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We all have different needs and preferences when it comes to consuming the media in 

our lives. Our students are the same. Some need webpages read aloud, some need 

different color schemes or fonts, and others need captions enabled on videos. Those are 

just a few of the things that can be done to improve the accessibility of documents, 

slides, videos, and websites used in our classrooms.  

 

Improving the accessibility of documents, slides, videos, and websites used to be a lot 

more difficult than it is today. Here are some tools that you and your students can use to 

improve the accessibility of media used in your classroom.  

 

Improve the Accessibility of Websites 

 

Microsoft Edge 

● If you have access to Microsoft Edge (the default for Windows computers) then 

should familiarize yourself with Microsoft’s Immersive Reader tool. Immersive 

Reader in Microsoft Edge can be used to have pages read aloud, to alter the font 

size and spacing, and to alter the color scheme of articles read on websites.  

 

● Microsoft Edge is also available to use on Android and iOS phones and tablets. A 

read-aloud function is available in the iOS and Android versions of Microsoft 

Edge.  

 

● Mac users aren’t left out of using Microsoft Edge and Immersive Reader. 

Microsoft Edge is currently (November, 2019) available as a beta product to 

install on Mac OS. It contains the Immersive Reader functions that are available 

in the Windows version of Edge. You can find the Mac OS version of Edge right at 

https://www.microsoftedgeinsider.com/en-us/?form=MO12FS&OCID=MO12FS 

 

Safari 

● Safari has a “reader view” option that you can find to the left of the URL in the 

address bar. The reader view menu appears as four horizontal lines. Click the 

https://www.microsoftedgeinsider.com/en-us/?form=MO12FS&OCID=MO12FS


menu to enter reader view. The reader view will lets users change the font style 

and size as well as the overall page color scheme.  

 

● Safari’s reader view is in addition to all of the other accessibility options that are 

built into the Mac operating system. A comprehensive list of Mac accessibility 

options is available at https://www.apple.com/accessibility/mac/  

 

Chrome 

● The Chrome web browser can be customized to each user’s preferences regarding 

font size, font style, and spacing. Those setting choices can be made by typing 

chrome://settings/fonts into the address bar in Chrome. The choices will apply 

as the default wherever you go in with Chrome.  

 

● You can zoom-in or zoom-out on individual pages in Chrome by simply holding 

the control key then tapping the  “+” key on a Windows or Chromebook keyboard 

or by holding the command key then tapping the “+” key on a Mac keyboard.  

 

● There are Chrome extensions that offer read-aloud capabilities. Read & Write for 

Chrome is one of the most popular ones for use in school settings. Other 

accessibility extensions can be found at 

https://chrome.google.com/webstore/category/ext/22-accessibility 

 

Firefox 

● The Firefox users can customize default font sizes, spacing, and colors. These 

options are available by opening the options menu listed under the “Tools” 

drop-down menu in Firefox. Alternatively, the options menu can be accessed by 

typing “about:preferences” (without quotation marks) into the address bar in 

Firefox.  

 

● Other accessibility options for Firefox include using a keyboard to navigate 

webpages, zooming to enlarge pages, and installing screen reader add-ons. You 

can enable keyboard navigation from the options menu under general settings. 

To zoom in to enlarge pages simply hold down the ctrl key then press the “+” key. 

To reverse that process hold ctrl and press the “-” key. A couple of screen reader 

add-ons for Firefox can be found at http://bit.ly/accsettings and complete list of 

Firefox accessibility settings is available at https://mzl.la/2DSxHhy  

 

 

https://www.apple.com/accessibility/mac/
https://chrome.google.com/webstore/category/ext/22-accessibility
http://bit.ly/accsettings
https://mzl.la/2DSxHhy


 

Improve the Accessibility of Your Slideshows 

 

● Automatic Subtitles for Your Live Presentations 

Both PowerPoint and Google Slides offer automatic subtitling tools that you can 

use when presenting to an audience.  

 

In Google Slides the subtitles appear at the bottom of your screen when you are 

in full-screen presentation mode. You can enable subtitles by entering 

presentation mode then hovering your cursor over the lower-left corner of your 

slides to make the subtitles option appear. This short video 

(https://youtu.be/cuH8n0UqpJU) provides a demonstration of how to enable 

subtitles in Google Slides.  

 

PowerPoint gives you the choice of having subtitles appear at the top or bottom of 

the screen when you are using the full-screen presentation mode. The process of 

enabling subtitles is slightly different depending upon whether you’re using the 

web browser version or desktop version of PowerPoint. In both versions the 

subtitles options are found by choosing the “slideshow” menu. This video 

(https://www.youtube.com/watch?v=DrLRJlbNlRc) demonstrates subtitles in 

the browser version of PowerPoint and this video 

(https://youtu.be/IvXO47uaPpc) demonstrates subtitles in the desktop version 

of PowerPoint.  

 

● Add Alt Text to Your Slides 

Alt text, short for alternative text, is text that you can add to images and videos to 

describe what they are and or what they contain. Adding alt text can make your 

slideshows accessible to people who use screen readers. The alt text describes 

what is in a picture, chart, or video that is included in a slide. PowerPoint, 

Keynote, and Google Slides all provide options for adding alt text to your 

presentations.  

 

To add alt text to images or videos in Google Slides simply right-click on the 

image or slide to which you need to add alt text. The menu that appears when you 

right-click on the image or video will include an alt text option where you can 

then write a title and description for the image or video. This 

https://youtu.be/cuH8n0UqpJU
https://www.youtube.com/watch?v=DrLRJlbNlRc
https://youtu.be/IvXO47uaPpc


(https://youtu.be/Z5RnzMfj9Qk) video provides a demonstration of how to add 

alt text to Google Slides.  

 

You can add alt text to PowerPoint slides by right-clicking on an image in your 

slides. One of the options that appears when you right-click on an image in 

PowerPoint is “edit alt text.” Select that option then write your description of the 

image.  

 

Keynote users can add alt text to images by selecting an image on a slide which 

then opens a panel on the right-hand side of the slide. In that panel select the 

image tab then add your alt text in the description box that appears at the bottom 

of the screen.  

 

Improve YouTube Video Accessibility 

 

YouTube can be a great source of educational videos to either display in your classroom 

or have students watch on their own. Fortunately, YouTube offers some easy ways to 

improve the accessibility of the videos that you use in your instruction.  

 

● Enable and Customize Captions Display 

You can enable captions on any YouTube video by clicking on the little “CC” icon 

in the lower-right corner of any video that you’re viewing. This will turn on the 

automatically generated captions for any spoken words in the video you’re 

viewing.  

 

The default size, style, and color of the automatic captions on a YouTube video 

may not work for every viewer. If that’s the case for you or your students, you can 

adjust how the captions are displayed. To adjust the captions display click on the 

small “gear” icon in the lower-right corner of the video that you’re viewing. Once 

you click that icon you’ll be able to select “subtitles/CC.” Within that menu there 

is an “options” menu that you can click on to select the size, style, and color of the 

captions display. This video (https://youtu.be/p0NgXg7A5U8) will walk you 

through the process of customizing the display of the captions on YouTube 

videos. 

 

 

 

https://youtu.be/Z5RnzMfj9Qk
https://youtu.be/p0NgXg7A5U8


● Edit the Captions on Your Videos 

If you’re making original videos for your students to watch, when you upload 

those videos to YouTube they will be automatically captioned. However, the 

automatic captions are not always accurate. For example, my last name is always 

captioned as “Bern” instead of it’s proper spelling of Byrne. You can edit the 

automatic captions. I’ve outlined the caption editing process in this video 

(https://youtu.be/4eCdC47AKJM).  

 

● Create a Transcript of any YouTube Video 

VidReader (vidreader.com) is a free tool that you can use to create a transcript of 

any YouTube video that has spoken English in it. To create a transcript with 

VidReader you simply copy and paste the URL of the video that you want 

transcribed. VidReader will then generate a transcript for you. The transcript will 

be time-stamped so that when students are reading the transcript they can click 

on any word in the transcript to jump to the corresponding section of the video.  

 

Improve Document Accessibility 

 

● Google Documents 

Google Documents has some built-in accessibility options that you should know 

how to enable. There are also some third-party Google Docs add-ons that can 

help you improve the accessibility of your documents.  

 

In Google Documents there is a built-in voice typing capability. To find the voice 

typing tool simply open the “Tools” drop-down menu then select “Voice typing.” 

A microphone icon will appear in the left margin of your document. Click it to 

activate your microphone then start speaking and your words will appear on the 

page. You will have to speak directions like “question mark” to add punctuation 

and “new line” to start writing on a new line.  

 

In the same “Tools” drop-down menu that contains the voice typing tool you will 

find the general accessibility settings menu. It is there that you can enable 

support for screen readers and screen magnifiers.  

 

On the topic of screen readers, when you insert an image into a Google Document 

you can right-click on it to bring up the option to add alt text. Alt text is text that 

https://youtu.be/4eCdC47AKJM
https://www.vidreader.com/


you add to an image to describe what is in the image. Screen readers will read the 

alt text.  

 

Grackle is a Google Docs and Slides add-on that will check your documents and 

slides for accessibility compliance. When you run Grackle's accessibility checker 

it will identify places where your slide doesn't meet accessibility standards. It 

makes suggestions for improvement on the areas in which your document, slide, 

or sheet doesn't meet accessibility standards. Some of the suggestions can be 

implemented with just a click from the Grackle Add-on menu while others are 

changes that you will have to make yourself. 

 

You can watch a demonstration of all of the Google Docs accessibility options 

mentioned above right here https://youtu.be/w90cW9sh3zs  

 

● Word Documents 

When it comes to accessibility options, Microsoft Word is far ahead of Google 

Documents. Not only does Word come with many built-in accessibility options, 

Word also contains extensive help documentation that can access without exiting 

the document that you are working on.  

 

Speech-to-text is built into the current versions of Word. To use speech-to-text 

simply open a new document then on the “Home” ribbon select “Dictation.” 

Dictation is available for a variety of languages in Word.  

 

Text-to-speech or read-aloud capabilities are available in Word through the 

power of Microsoft’s Immersive Reader. Immersive Reader will read documents 

aloud. Additionally, Immersive Reader can be used to alter the spacing of a 

document, to highlight words and syllables while the document is read aloud, and 

to highlight parts of speech as a document is read aloud. Immersive Reader can 

be found in the “View” menu in Word.  

 

Microsoft Word has a built-in accessibility checker. You can find the accessibility 

checker under the “Review” menu in Word. Simply click “Check Accessibility” 

and Word will run an accessibility check then give you feedback on areas for 

improving the accessibility of your document. That feedback will appear in the 

right margin of your document. Below the suggestions for improvement you will 

see a link to “read more about making documents accessible.” Click that link will 

open help documentation and suggestions that you can read in while 

simultaneously implementing them into your current document.  

https://youtu.be/w90cW9sh3zs


 

Microsoft offers a good video overview of Word’s accessibility checker. That video 

is available at 

https://support.office.com/en-gb/article/video-check-the-accessibility-of-your-d

ocument-9d660cba-1fcd-45ad-a9d1-c4f4b5eb5b7d 

 

 

More About Immersive Reader 

As mentioned in the sections about the Edge web browser and Word, Microsoft’s 

Immersive Reader is a fantastic accessibility tool. Not only can it be used as a read-aloud 

tool, it can also be used to alter the font size, font spacing, and page color schemes of 

pages that students view. And Immersive Reader includes a picture dictionary tool for 

students to use. Microsoft’s official guide to Immersive Reader can be found at 

http://bitly.com/33Qt3Lx  

 

Immersive Reader is available in most of the Microsoft products in use in schools today 

including OneNote, Word, Forms, Teams, Office Lens, Flipgrid, and Outlook. 

Additionally, Immersive Reader has been incorporated into more than a dozen popular 

third-party programs including Thinglink, Wakelet, and Nearpod. The full list of 

third-party services that have incorporated Immersive Reader can be found at 

http://bitly.com/immr3rd  

 

https://support.office.com/en-gb/article/video-check-the-accessibility-of-your-document-9d660cba-1fcd-45ad-a9d1-c4f4b5eb5b7d
https://support.office.com/en-gb/article/video-check-the-accessibility-of-your-document-9d660cba-1fcd-45ad-a9d1-c4f4b5eb5b7d
http://bitly.com/33Qt3Lx
http://bitly.com/immr3rd

